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Prefácio 
 
 

Longe de ser completo, este documento remete apenas para a 
ponta do iceberg. Compromete-se, contudo, a dar uma visão 
generalista das técnicas utilizadas na elaboração das presentes 
páginas da Faculdade de Engenharia da Universidade do Porto e a 
ser um ponto de partida para um aprofundamento mais rigoroso 
das mesmas. Simultaneamente, pretende dar apoio e orientação 
aos indivíduos da comunidade da FEUP e às unidades da sua 
estrutura que desejem criar páginas WWW. 

Este livro não é um manual de HTML e muito menos um 
manual do programa Photoshop. Assume-se que o leitor possui um 
mínimo de conhecimentos sobre estas duas matérias. 

Não foram abordadas neste livro as técnicas de Perl utilizadas 
no livro de visitas, nem a introdução do contador na página de 
escolha de idioma. A referência aos recursos da Oracle utilizados 
na criação dinâmica de páginas HTML a partir de informação 
estruturada numa base de dados, também sairia fora do âmbito 
deste livro, além de se situarem para lá do meu conhecimento. 

As novas páginas da Faculdade de Engenharia da Universidade 
do Porto, nasceram no Centro de Informática Professor Correia 
de Araújo (CICA), numa equipa —  SiFEUP —  da qual faço 
parte, estando sob a minha responsabilidade todo o design 
inserido. César Silva é o responsável pela programação HTML de 
base e rotinas em Java Script e Perl. A coordenação do SiFEUP é 
feita pela Doutora Lígia Ribeiro e o Professor Gabriel David, 
estando este último responsável pela equipa que coordena os 
recursos da Oracle: o Engenheiro Jorge Wilson e o Engenheiro 
Manuel Machado. 

Queria aqui agradecer a todas estas pessoas pelas sugestões que 
me têm dado, para além da confiança que depositaram em mim. 

Procurei escrever o presente documento com uma linguagem 
acessível, mas existem certos termos técnicos aos quais não se 
pode fugir.  Também não tentei fazer traduções de alguns termos, 
sob o perigo de errar. 

Espero comentários sobre este documento no seguinte email: 
 
 
 

vitor@fe.up.pt 
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Páginas Web 
da FEUP 

 
Do conceito base, 

às técnicas de programação HTML 
e manipulação gráfica 

 
 

I. Princípios gerais das páginas da FEUP 
 
 A ideia basilar que esteve presente no desenvolvimento das actuais 
páginas da Faculdade de Engenharia da Universidade do Porto, assenta num 
conjunto de tópicos que podem ser considerados como normas ou 
princípios para tudo o que se possa seguir, quer sejam actualizações, seja o 
desenvolvimento de futuros módulos: 
 

?? Manutenção da imagem e simbologia da FEUP; 
?? Estruturação básica das páginas; 
?? Grafismo simples e informal; 
?? Obtenção do melhor produto pelo menor volume de dados 

transferidos; 
?? Respeito pelos utilizadores que possuam requisitos considerados 

"mínimos" de sistema (esta definição será explicitada mais 
adiante). 

 
Manutenção da imagem e simbologia da FEUP 
 
 Considerou-se existirem três elementos fundamentais com os quais a 
FEUP de identifica: 
  

?? O seu emblema oficial: "Virtus Unita Fortius Agit"; 
?? A cor de Engenharia; 
?? O Edifício Central. 

 
É perfeitamente natural que os respectivos ícones acompanhem de 

forma marcada cada uma das páginas da FEUP. De facto, os dois primeiros 
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estão presentes em quase todas elas —  a excepção vai para a página de 
escolha de idioma, onde  o emblema oficial não figura. 

A presença constante destes dois atributos, uniformiza as páginas e 
confere-lhes personalidade. 

Depois da Página de Escolha de Idioma (Figura 1), surge a Página Principal 
da FEUP (Figura 2), contendo todos os elementos identificativos atrás 
descritos. 
 

 
Figura 1 

 
Estruturação básica das páginas 
 
 As páginas estão divididas em duas áreas: a área dos tópicos, ou 
elementos do menu de escolha múltipla, e a área da informação, na qual se 
explanam os dados sobre um determinado tópico. A interpenetração destas 
duas áreas nunca deve ser considerada. 
 Em qualquer altura, e em qualquer página, o utilizador deve ser capaz 
de aceder facilmente a todos os outros elementos do menu. 
 O símbolo da FEUP, presente no canto superior esquerdo (com a 
excepção já atrás referida), deve dar acesso à Página Principal. 
 Toda e qualquer informação deve ser encimada por um título 
esclarecedor e abreviado do seu conteúdo e com um ícone alusivo. 
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 É válido colocar, dentro da área reservada à informação, ligações 
(links) para outras matérias. Estas ligações podem aparecer: 
  

?? Em forma de botão; 
?? Em forma de texto; 
?? Em forma de imagem; 

 
O menu de escolha múltipla contido na área dos tópicos pode, em 

certos módulos (ex: documentos na página de Notícias), ser substituído por 
um novo menu contextual. 
 
Grafismo simples e informal 
 
 Todo o grafismo das páginas da FEUP pretende ser descontraído, de 
modo a cativar a atenção do cibernauta. Mais do que meros elementos 
decorativos, os gráficos têm como função: 
 

?? Tornar as páginas mais legíveis; 
?? Chamar a atenção para pontos particulares das páginas; 
?? Complementar o conteúdo apresentado textualmente; 
?? Humanizar as páginas. 

 
É ponto assente que todo o grafismo deve ser original. 

 
Obtenção do melhor produto pelo menor volume de dados 
transferidos 
 
 Uma das coisas mais desesperantes na Internet é o tempo infindável de 
certas transferências de informação (downloads). Esse tempo é directamente 
proporcional à quantidade de dados a serem transmitidos (como é óbvio). 
Se, por um lado, é possível criar um documento fonte bastante extenso sem 
que para isso necessite de muitos Kbytes de memória de massa (lembre-se 
que um ficheiro HTML tem formato ASCII), o mesmo já não se pode dizer 
em relação às imagens ou a certos artifícios que são utilizados juntamente 
com o HTML. 
 Nas páginas da FEUP, deverá haver uma escolha criteriosa de tudo o 
que se pense lá colocar no sentido de optimizar a transferência de 
informação. A lista seguinte torna mais fácil esta escolha: 
 

?? Nunca ultrapassar os 30 Kbytes em imagens (a soma do espaço 
ocupado por todas as imagens de uma página nunca deve exceder 
esse valor); 
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?? Nunca colocar grafismo despropositado ou com funções 
unicamente decorativas; 

?? Fazer uma escolha sensata entre formatos de imagem. Os GIF's 
resultam bem com certo tipo de imagens (geralmente desenhos 
com poucas cores) e os JPEG's com outro tipo (geralmente em 
fotografias). Em caso de dúvida latente, é sempre possível fabricar 
ficheiros com as duas extensões, atender à dicotomia qualidade de 
imagem / tamanho do ficheiro e fazer uma opção inteligente. 

 
Respeito pelos utilizadores que possuam requisitos "mínimos" de 
sistema 
 
 As páginas da FEUP, representativas de uma instituição, são acedidas 
por milhares de pessoas todos os meses (a média de acessos nos últimos 25 
meses está na fasquia dos 12 260). Desses milhares, poucos terão acesso a 
redes com grande largura de banda (ou por outras palavras, a ligações 
rápidas), a modems capazes de receber fluentemente a quantidade de 
informação disponibilizada, ou placas de vídeo, computadores e monitores 
com óptimas especificações. 
 Há portanto a necessidade de definir um meio termo em que nem 
estes cibernautas, nem os mais afortunados saiam a perder. Sendo assim, 
houve que definir uma fasquia para os requisitos de sistema ao alcance da 
maioria dos utilizadores. Estes requisitos são: 
 

?? Resolução de imagem: 800 x 600; 
?? Quantidade de cores: 255 
?? Versão 3.0 ou superior do Netscape - A compatibilidade é quase 

total com outros browsers como o Microsoft Explorer, embora em 
versões mais antigas, certas marcas (tags) utilizadas não sejam 
reconhecidas. Os problemas costumam surgir na centragem de 
textos ou imagens. 

 
As páginas da FEUP são planeadas para correrem com a janela do 

browser  maximizada. 
 
II. Técnicas de programação HTML utilizadas 
 
 Ao longo deste segundo capítulo, parte-se do princípio que o leitor 
possui um mínimo de conhecimentos de programação em HTML. 
 As páginas foram estruturadas recorrendo a tabelas. Elas permitiram 
uma segmentação do ecrã em duas áreas distintas: uma delas é estática —  a 
parte esquerda que contém o menu de escolha múltipla —  e faz parte do 
esqueleto básico de todas as páginas. Se o cibernauta possuir uma memória 
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cache no seu browser, esta parte da página é sempre carregada da memória do 
computador e não através da Internet, o que reduz subtancialmente o tempo 
de transferência. 
 A parte direita do ecrã é activa, sendo modificada em cada uma das 
páginas consoante a informação disponibilizada. 
 
Utilização de Frames 
 
 Embora numa primeira fase do projecto, a estruturação das páginas 
através de frames não fosse contemplada, a evolução da Internet e do software 
de acesso, fez com que se ponderasse de novo essa solução. De facto, no 
presente, a versão inglesa das páginas da FEUP utilizam frames. As tabelas 
continuam a ser utilizadas no entanto, para a formatação das páginas. 
 Num futuro próximo, a versão portuguesa seguirá também essa via. 
 
Interpretação do código HTML de uma página tipo 
 
 Pede-se ao leitor que observe a Figura 2 à medida que se explica o 
respectivo código. 
 

 
Figura 2 
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<html> 
   
  <head> 
    <META NAME="KeyWords" CONTENT="Engenharia, Faculdade de    
    Engenharia, FEUP"> 
    <title>Faculdade de Engenharia da Universidade do Porto</title>  
 
    <script language="JavaScript"> 
    <!--  
      /* 
        Direitos de Autor (C)1997 C.I.C.A.  
        Todos os direitos reservados.  
        Este codigo pode ser re-usado ou modificado, 
        caso o devido credito seja dado no codigo fonte.  
        Nao nos responsabilizamos por quaisquer efei tos indesejados 
        Relativos ao uso deste codigo ou derivados. Nao se dao  
        garantias de aplicabilidade em qualquer tipo de caso.  
        Cesar Silva, 16 de Setembro, 1997.  
        Ver os agradecimentos na pagina anterior :)  
      */ 
      if (top != self) 
      {top.document.location.href = self.document.location.href}  
    // --> 
    </script> 
  </head> 
 
 Esta parte do código introduz o nome da página na janela do browser e 
contém uma rotina em Java Script que impede que as páginas da FEUP sejam 
abertas dentro de uma frame. 
 
<body background="img/back2.jpg" link="#800000" vlink="#C0C0C0">  
 
 Aqui é especificada a imagem para o fundo, bem como a cor padrão 
para as ligações visitadas e não visitadas. 
 
<table width=775 border=0> 
 
 Delimita-se a largura máxima da tabela, bem como a espessura das 
suas linhas. Para todos os efeitos, atribuindo o valor zero à marca border, 
torna-se a tabela transparente. Como já atrás foi dito, recorreu-se às tabelas 
apenas como forma de estruturar as páginas e não pelas tabelas em si. 
 
<tr> 
  <td width=180 halign=left valign=top>  
    <p> 
 
 Inicia-se uma linha na tabela e define-se a primeira célula (a da 
esquerda, já que a ordem de preenchimento das células é igual à ordem pela 
qual se lê um livro de banda desenhada: da esquerda para a direita e de cima 
para baixo). 
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 A nova célula tem uma largura pré-definida de 180 pixels, um 
alinhamento horizontal pela esquerda e um alinhamento vertical de topo, ou 
seja: os textos ou imagens começãm a ser inseridos no topo da célula. 
 
<p> 
  <spacer type="vertical" size=5> 
 
 Começa-se a definição dos atributos da célula. 
 
<a href="bem-vindo.html" onMouseOver="window.status='P&aacute;gina 
Inicial da FEUP';return true" onmouseout="window.status=' ';return 
true"><img src="img/feup.jpg" border=0 hspace=20></a><p> 
 
 Aqui é inserida a imagem com o símbolo da FEUP, que dá sempre 
acesso em qualquer das páginas à Página Principal. 
 

<a href="noticias.html" 
onMouseOver="window.status='Not&iacute;cias';return true" 
onmouseout="window.status=' ';return true"><img 
src="img/listanoticias.gif" width=157 height=19 border=0 
alt="Notícias"></a> 
      <a href="http://rufus.fe.up.pt:8881/leg/owa/w_inicio$.startup" 
onMouseOver="window.status='Legisla&ccedil;&atilde;o';return true" 
onMouseOut="window.status='';return true"><img 
src="img/listalegislacao.gif" width=157 height=19 border=0 
alt="Legisla&ccedil;&atilde;o"></a> 
      <a href="departamentos.html" 
onMouseOver="window.status='Departamentos';return true" 
onmouseout="window.status=' ';return true"><img 
src="img/listadepartamentos.gif" width=157 height=19 border=0 
alt="Departamentos"></a> 
      <a href="servicos.html" 
onMouseOver="window.status='Servi&ccedil;os';return true" 
onmouseout="window.status=' ';return true"><img 
src="img/listaservicos.gif" width=157 he ight=19 border=0 
alt="Servi&ccedil;os"></a> 
      <a href="cursos.html" onMouseOver="window.status='Cursos 
Ministrados';return true" onmouseout="window.status=' ';return 
true"><img src="img/listacursos.gif" width=157 height=19 border=0 
alt="Cursos"></a> 
      <a href="id.html" 
onMouseOver="window.status='Investiga&ccedil;&atilde;o & 
Desenvolvimento';return true" onmouseout="window.status=' ';return 
true"><img src="img/listai&d.gif" width=157 height=19 border=0 
alt="Investiga&ccedil;&atilde;o e Desenvolvimen to"></a> 
      <img src="img/listacooperacao.gif" width=157 height=19 border=0 
alt="Coopera&ccedil;&atilde;o"></a> 
      <a href="http://rufus.fe.up.pt:8881/sifa/owa/web_doc$.Startup" 
onMouseOver="window.status='Pessoal';return true" 
onmouseout="window.status=' ';return true"><img 
src="img/listapessoal.gif" width=157 height=19 border=0 
alt="Pessoal"></a> 
      <a href="alunosindex.html" 
onMouseOver="window.status='Alunos';return true" 
onmouseout="window.status=' ';return true"><img 
src="img/listaalunos.gif" width=157 height=19 border=0 
alt="Alunos"></a> 
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      <a href="pesquisaindex.html" 
onMouseOver="window.status='Pesquisa';return true" 
onmouseout="window.status=' ';return true"><img 
src="img/listapesquisa.gif" width=157 height=19 border=0 
alt="Pesquisa"></a> 
  

O menu de escolha múltipla consegue-se através de vários GIF's 
transparentes que contéem os elementos de texto. 
 Nesta parte do código introduz-se ainda um mimo em Java Script. Cada 
ligação possui uma pequena parcela nesta linguagem que faz aparecer na 
janela de status do browser um texto alusivo (por exemplo: 
OnMouseOver="window.status='Cursos Ministrados'; return true" 
OnMouseOut="window.status=' ';return true" ). 
 
<p> 
  </td> 
  <td valign=top width=595> 
    <div align=center> 
    <img src="img/titles/tituloprincipal.gif" border=0 hspace=5>  
    <p><a href="asprela.html"><img  
    src="img/photos/ed-central-media.jpg" border=0 width="460"  
    height="271"></a> 
    <spacer type=vertical size=10> 
    <p><a href="apresentacao.html"       
    onMouseOver="window.status='Apresentação da Faculdade';  
    return true" onmouseout="window.status=' ';return true"><img  
    src="img/icons/botaoapresentacao.gif" width=105 height=20  
    alt="Apresenta&ccedil;&atilde;o" border="0"></a><a  
    href="http://www.fe.up.pt/feupwww/apontadores.html"   
    onMouseOver="window.status='Apontadores';return true"  
    onmouseout="window.status=' ';return true"><img  
    src="img/icons/botaoapontadores.gif" width=95 height=20  
    alt="Apontadores" border="0"></a><a  
    href="http://webforos.fe.up.pt:1313/" target="NEW"  
    onMouseOver="window.status='webforos.fe.up.pt'; return true"  
    onmouseout="window.status=' ';return true"><img  
    src="img/icons/botaoforos.gif" width=52 height=20  
    alt="webforos.fe.up.pt" border="0"></a><a  
    href="http://www.fe.up.pt/feupwww/ajuda/Inicial.htm"  
    onMouseOver="window.status='A ajuda do SiFEUP';return true"  
    onmouseout="window.status=' ';return true"><img  
    src="img/icons/botaoajuda.gif" width=51 height=20 alt="Ajuda"  
    border="0"></a><a  
    href="http://atlantis.fe.up.pt/~mentor/feup/visitas.html"  
    onMouseOver="window.status='O livro de visitas da FEUP';return  
    true" onmouseout="window.status=' ';return true"><img  
    src="img/icons/botaolivrovisitas.gif" widt h=117 height=20  
    alt="Livro de Visitas" border="0"></a>  
 
 É iniciada a célula da direita. Todo o texto e imagens que se seguem, 
vêm centrados graças à marca <div align=center>. 
 Colocou-se o GIF com o título "FACULDADE DE 
ENGENHARIA DA UNIVERSIDADE DO PORTO", bem como o 
JPEG do Edifício Central. 
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 Entre dois espaços verticais de 10 pixels, colocam-se as imagens de 
cinco botões que estabelecem a ligação para a Página de Boas-Vindas do 
Director da Faculdade, a página de Apontadores, a página de Foros, a página de 
Ajuda e a página do Livro de Visitas. 
 
<p> 
  <font size=2> 
  <i> 
  Faculdade de Engenharia da Universidade do Porto<br>  
  Rua dos Bragas 4099 Porto Codex<BR>  
  Portugal<BR> 
  Tel: 02-204 1600<BR> 
  FAX: 02-200 0808 
<p> 
  <a href="mailto:webmaster@fe.up.pt">webmaster@fe.up.pt</a> 
  </i> 
<p> 
  <font size="2"><a href="http://www.fe.up.pt/feupwww/english/"  
  target="_top" onMouseOver="window.status='This page in English';  
  return true" onmouseout="window.status=' ';return true"><img  
  src="http://www.fe.up.pt/feupwww/img/ukplease.jpg" width=192  
  height=20 border="0" alt="This page in English"></a></font>  
 

Este pedaço de código diz respeito a uma parte da página que não 
aparece na Figura 2. Aqui colocam-se o endereço da FEUP, uma ligação 
para enviar email ao Webmaster e a ligação para a versão inglesa das páginas. 

 
    </div> 
  </td> 

      </tr> 
    </table> 
  </body> 
 
</html> 

 
A célula é fechada, a tabela é fechada, o corpo da listagem é fechado, 

bem como o próprio ficheiro HTML. 
Todas as outras páginas são feitas mais ou menos da mesma forma. 

 
Editor HTML utilizado 
 
 Utilizou-se um editor de páginas HTML que dá pelo nome de 
HomeSite (encontrará uma versão shareware deste programa em 
http://www.allaire.com/). A particularidade de se ter utilizado um editor de 
código HTML what you write is what you get e não um editor do tipo what you see 
is what you get permitiu que se fugisse às marcas desnecessárias e ao código 
mal estruturado, que resultou numa menor memória de massa ocupada pelo 
ficheiro. 
 Por outro lado, a utilização do editor em vez de um vulgar editor de 
texto, trouxe algumas facilidades: 
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?? Substituição automática dos caracteres acentuados pelos seus 
códigos HTML equivalentes (por exemplo, substituir ã por 
&atilde;). 

?? Introduzir as imagens no código pelo sistema drag and drop; 
?? Estruturar o código de uma forma lógica e torná-lo minimamente 

legível; 
?? Multisessões com vários códigos fonte, o que permitiu uma 

comparação mais eficaz entre eles; 
?? Criação de certas macros que eram repetidamente utilizadas ao 

longo das páginas. 
?? Introdução de parcelas de código totalmente automática. 

 
III. Técnicas de manipulação gráfica utilizadas 
 
 Quer se queira, quer não, fomos habituados pelos media a ser 
exigentes em questão de design. Sabe-se por experiência própria que não 
basta disponibilizar informação: há que saber como disponibilizar, há que 
saber estruturar essa mesma informação. O design é uma das técnicas mais 
versáteis no que toca a tornar tragável e fácil aceder a um conjunto 
relativamente vasto de informação. Não é de espantar, por isso, que o design 
das páginas da FEUP tenha sido cuidadosamente estudado, pois existe um 
conjunto de factores que limitam os horizontes da imaginação e que se 
prendem com diversos tópicos atrás mencionados. 
 O programa utilizado para toda a manipulação gráfica das páginas da 
FEUP, foi o Adobe Photoshop versão 3.0.5 que permitiu, entre outras 
potencialidades, a criação de GIF's transparentes. No presente, a versão 
utilizada é a 5.0. Todos os passos que se seguem dizem respeito a esta última 
versão. 
 Ao longo deste capítulo, parte-se do princípio que o leitor possui um 
mínimo de conhecimentos sobre a utilização deste programa. 
 Nas páginas da FEUP são utilizados seis tipos de elementos a partir 
dos quais se criam todos os outros. 
 
Criação da imagem de background 
 
 As páginas da FEUP possuem uma imagem de background que foi 
criada com dois intuitos: 
 

?? Permitir uma leitura fácil de todo o texto e imagens inseridas; 
?? Ser identificada com a FEUP. 
 
O primeiro item foi consguido introduzindo o branco como fundo 

para todos os textos e imagens da parte activa das páginas. 
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O segundo item foi conseguido introduzindo um gradiente desde a 
cor de engenharia até ao branco. Esta variação ocorre apenas na zona passiva 
das páginas. 

O browser, ao encontrar uma uma imagem para ser colocada como 
background, repete-a várias vezes ao longo de todo o ecrã como se fosse uma 
textura de papel-de-parede, Contornou-se este inconveniente criando uma 
imagem que ultrapassava a largura do ecrã para a maior parte das definições. 
Para todos os efeitos, a imagem só se repete segundo a vertical. 

Abriu-se, assim, um novo documento no Photoshop com as dimensões 
de 1300 x 10 pixels. De seguida, mantendo o branco como cor de background, 
escolheu-se a Cor de Engenharia para foreground que possui as seguintes 
especificações: 

 
?? Red: 152 
?? Green: 67 
?? Blue: 47 

 
Utilizou-se uma ferramenta pré-definida do Photoshop: a Gradient Tool 

(Figura 3),  cujo botão se encontra na Tool Bar. 
Para se definir o tipo de efeito pretendido, clica-se duas vezes sobre 

este ícone para exibir o menu Gradient Tool Options e em Style, define-se a 
opção Foreground to Background. 

 
Figura 3 

 
Para criar o dito efeito de gradiente, há que seleccionar o ícone 

Gradient Tool e, sobre o novo documento, seleccionar o ponto mais à 
esquerda da imagem, utilizando o botão esquerdo do rato e, com a tecla 
SHIFT do teclado pressionada (para ser criada uma linha horizontal), 
arrastar a linha de gradiente com o rato até cerca de 1/8 da largura total da 
imagem, libertando o botão de seguida. O efeito conseguido, deverá 
parecer-se com a Figura 4. 

 

 
Figura 4 

 
Grava-se então o ficheiro em formato JPEG, de resolução 3 (média). 

De facto, daqui para a frente, sempre que se crie um ficheiro JPEG, utilize 
esta resolução. 
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Criação do símbolo da FEUP 
 
 Para este logotipo, houve que partir de um ficheiro que continha a 
digitalização do símbolo da FEUP. Para se obter uma boa apresentação, 
escolheu-se a opção Black and White Photo no scaner. O ficheiro obtido é o 
que aparece na Figura 5, criado por defeito em modo Indexed Color. O 
Photoshop permite apenas a manipulação de imagens em modo RGB Color, 
logo, teve de alterar-se este atributo com Image > Mode > RGB Color. 

 
Figura 5 

 
 Novamente, o Photoshop fornece uma ferramenta própria para o efeito 
que desejamos obter: Emboss —  Filter > Stylize > Emboss… . Escolhida 
esta opção, aparecerá a janela de diálogo da Figura 6, na qual se indicam os 
seguintes valores: 
 

?? Angle: 135º 
?? Height: 4 pixels 
?? Amount: 100% 

 
 As combinações entre estes três valores dão origem a um número 
quase infinito de efeitos Emboss. No entanto, foram estes valores que 
produziram os melhores resultados. 

 
Figura 6 
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 A imagem conseguida na Figura 7 foi gravada em formato JPEG. 

 
Figura 7 

 
Criação de títulos 
 
 Todos os títulos das páginas da FEUP (com excepção da Página de 
Escolha de Idioma) são GIF's. Existem basicamente dois tipos de títulos 
utilizados.Um deles aplica-se apenas à Página Principal; o segundo tem um 
uso generalizado e consiste em criar dinamicamente qualquer título 
recorrendo a um arquivo de imagens que contém todas as letras do alfabeto. 
O sistema utilizado assemelha-se ao contador. 
 O efeito de sombra presente nestes títulos costuma provocar uma 
excelente ilusão e contribui para o embelezamento geral das páginas. 
 Aprenderá de seguida a fabricar cada um destes dois tipos de títulos. 
 O primeiro passo é escolher uma cor convincente para a sombra, que 
ficará algures entre as tonaliades de cinzento. Na janela Swatches do  Photoshop 
Window > Pallettes > Show Swatches, escolhe-se a cor do canto superior 
direito que tem as seguintes especificações: 
 

?? Red: 128 
?? Green: 128 
?? Blue: 128 

 
Esta cor situa-se sensivelmente a meio da escala de cinzentos, 

demaneira a estabelecer um compromisso entre o demasiado claro e o 
demasiado escuro. 

 
Figura 8 

 
 Todo o texto que se inserir, recorrendo à Text Tool da Tool Bar, terá 
essa cor. 
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Figura 9 

 
 Abrindo um novo documento, seleccionando a Type Tool e 
seleccionando a janela do novo documento, surge-nos a janela de diálogo da 
Figura 10, onde se escolheram as seguintes especificações 
 

?? Font: Impact Regular 
?? Size: 30 points 
?? Alignment: Center 
?? Auto Kern 
?? Anti-Aliased 

  
Figura 10 

 
 Convém neste momento dizer o que se entende por aliasing e a 
maneira como ele pode afectar a aparência de uma imagem. 
 Aliasing é a palavra que define a incapacidade que um computador tem 
de gerar linhas curvas. Qualquer objecto desenhado pelo computador que se 
pretenda curvo, terá maior ou menor taxa de aliasing, consoante a resolução 
da placa gráfica. 
 O ecrã do computador contém uma espécie de matriz composta por 
minúsculos quadradinhos a partir dos quais se gera tudo o que nele possa 
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aparecer. Quanto menor for a resolução da imagem, mais se notarão esses 
quadradinhos. Vejamos a Figura 11: 
 

Figura 11 
 
 Ela sofre inequivocamente do efeito aliasing. Os contornos não são 
suaves. O computador pode no entanto tentar passar por cima deste 
inconveniente, esbatendo os contornos da imagem para uma escala de 
cinzentos, obtendo-se o resultado da Figura 12. 
 

Figura 12 
  
 A diferença é notória. Esta imagem foi gerada com o sistema Anti-
Aliased.  
 Mas voltemos ao título. 
 Inserindo o texto na janela apropriada e seleccionando OK, o texto 
aparecerá no documento, podendo ser posicionado onde se quiser. 
 Uma sombra é sempre algo de difuso, algo pouco delineado, logo, 
convirá esbater este texto, utilizando outro filtro do Photoshop. 
 Depois de ter feito Render à layer que contém o texto, seleccione Filter 
> Blur > Gaussian Blur… . Chega-se à janela de diálogo da Figura 13. 
 

  
Figura 13 
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Faz-se a seguinte escolha: 
  

?? Radius: 3 pixels 
 
 Este parâmetro corresponde à taxa de esbatimento pretendida. 
 Depois destes procedimentos, há que mudar a cor de Foreground para 
branco e seleccionar novamente a Type Tool. Introduza o mesmo texto e 
clique OK. Posicione agora o novo texto sensivelmente no mesmo sítio 
onde se encontra o efeito de sombra. O resultado obtido deverá ser 
equivalente ao da Figura 14. 

 
Figura 14 

 
 Para o outro tipo de títulos, bastará seguir os passos anteriores, 
apenas com quatro pequenas alterações: 
 

?? Arial será o tipo de letra; 
?? A cor de Foreground escolhida para a inserção do segundo texto 

deverá ser o preto; 
?? O Radius da Blur Tool deverá ser menor: cerca de 2 pixels. 
?? O segundo texto deverá posicionar-se não no mesmo lugar que a 

sombra, mas um pouco para a esquerda e para cima. 
 
 O resultado obtido deverá ser parecido com o da Figura 15. 

 
Figura 15 

 
Criação do menu de escolha múltipla 

 
 Como já foi dito num capítulo anterior, o menu de escolha múltipla é 
um conjunto de GIF’s transparentes que contêm texto. 
 O texto é inserido no novo documento recorrendo à Type Tool, mas 
desta vez sem a opção Anti-Aliased por uma razão muito simples: a tal 
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gradação de cinzentos destinada a esbater os contornos das letras, não 
produz resultados satisfatórios quando utilizada em GIF’s transparentes. O 
que acontece na realidade é que ao escolher as cores para transparência 
corre-se o risco de não tirar todas as cores que deveria ou, tirando-as, as 
letras ficarem imperceptíveis. 
 Transforme a imagem para Indexed Color utilizando Image > Mode > 
Indexed Color…  e escolha a pallette de cores Web. De seguida, crie o GIF 
transparente File > Export > GIF89a Export…  resultando na janela de 
diálogo GIF89a Export Options. 
 Nesta janela, escolhe-se a cor que deve assumir a propriedade de 
transparência, no caso, o branco. 
 Seleccionando OK, grava-se o ficheiro em formato GIF. 
 
Criação de botões 
 
 Os botões são elementos que estabelecem ligações para novas páginas 
HTML, dentro do conjunto das páginas da FEUP e apenas aparecem na 
zona activa das mesmas. 
 Para o botão que servirá de exemplo a esta demostração, começa-se 
por abrir um documento com as dimensões 100 x 20 pixels. 
 Os cantos dos botões são semi-círculos, pelo que se começa por  
delimitá-los.  Carrega-se na Marquee Tool (Figura 16). 

 
Figura 16 

 
 Mantendo a tecla SHIFT pressionada (para que a forma a obter seja 
uma circunferência perfeita e não uma elipse), devemos seleccionar com o 
rato o extremo superior esquerdo do documento e arrastar a circunferência 
gerada até que ela abarque toda a dimensão vertical do ficheiro, largando de 
seguida o botão do rato. 
 
 Há  que pintar agora a área seleccionada com a cor que possui as 
seguintes especificações: 
 

?? Red: 128 
?? Green: 0 
?? Blue: 25 

 
 Para tal, basta colocar a referida cor em Foreground, e pressionar ALT 
+ DELETE. Deixando ainda seleccionada a referida área, pressiona-se 
CTRL + C seguido de CTRL + V. Um círculo idêntico irá sobrepôr-se ao 
anterior. Arraste este último para a parte direita da imagem e pinte o espaço 
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entre eles da mesma cor, tendo o cuidado de não deixar seleccionada 
previamente nenhuma área. 
 
 Por esta altura, deverá ter-se qualquer coisa parecida com a Figura 17. 
 

 
Figura 17 

 
 O passo seguinte será seleccionar toda a área pintada recorrendo à 
Magic Wand Tool (Figura 18). 

 
Figura 18 

 
 Está agora em condições de passar à fase seguinte, que consiste em 
aplicar efeitos de luzes ao botão a ser gerado. O leitor já deve calcular que, 
mais uma vez, o Photoshop fornece uma ferramenta para este efeito. 

Fazendo Filter > Render > Lighting Effects…  aparece a janela de 
diálogo da Figura 19, onde deverá escolher as seguintes opções: 
 

?? Style: FLASH 
?? Light type: Omni 
?? Intensity: 23 
?? Gloss: Matte (-50) 
?? Material: Plastic (-50) 
?? Exposure: 0 
?? Ambience: -12 
?? Texture Channel: None. 

 
 Deve-se colocar o foco sensivelmente a meio do botão e colocar o 
raio de abrangência de luz para perto das suas extremidades. 

 
Figura 19 
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 Para aplicar o efeito de luzes, seleccione OK. 
 Falta inserir o texto do botão, recorrendo à Text Tool, depois de se 
escolher o branco para cor Foreground. 
 Ficam aqui as especificações da fonte: 
 

?? Font: Bookman Old Style 
?? Size: 12 pixels 
?? Spacing: 2  
?? Style: Bold 

 
 O resultado final deverá ser o da Figura 20, depois do texto 
posicionado correctamente no centro do botão (CTRL + A, CTRL + X, 
CTRL + V, na Layer do texto depois de fazer Render). 
 

 
Figura 20 

 
Criação de ícones 
 
 Os ícones, que devem preceder quase todos os títulos, são de 
execução fácil. 
 Tendo já um ficheiro contendo um desenho (Figura 21) elaborado no 
Photoshop, bastará aplicar cor ao mesmo. 

 
Figura 21 

 
 O processo utilizado para este efeito caracteriza-se pela sobreposição 
de uma segunda camada no desenho, onde irão ser aplicadas as cores. 
 Fazendo Window > Pallettes > Show Layers aparecerá a janela de 
diálogo da Figura 22. 

 
Figura 22 
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  Seleccionando o quadradinho do centro na parte inferior da janela, 
cria-se uma nova Layer. 
 Eis as opções que devemos seleccionar para esta Layer: 
 

?? Opacity: 40% 
?? Mode: Normal 

 
 Qualquer coisa que se acrescente ao desenho passará a ter efeito 
apenas nessa camada: o desenho que se encontra por baixo, não sofrerá 
nenhuma alteração. 
 É natural que as cores pareçam mais claras, pois a opacidade desta 
nova camada é de apenas 40%. O efeito pretendido é o de uma pintura 
despreocupada com lápis de cera, onde as cores geralmente saem fora dos 
traços do desenho. 
 O desenho da Figura 23 é um bom exemplo do efeito pretendido. 
 Todos os ícones foram gravados em ficheiros com o formato JPEG. 
 

 
Figura 23 

 
IV. Conclusão 
 
 Convido agora o leitor a experimentar tudo o que foi exposto neste 
documento, quer no que diz respeito ao HTML, quer à manipulação gráfica. 
Tanto o HomeSite como o Photoshop são programas que exigem uma certa 
dedicação para que se consiga descobrir tudo aquilo que são capazes de 
fazer. 
 Sou da opinião que um livro de computadores, só por si, não chega! 
Tem de haver contacto coma máquina! Há que cometer alguns erros para 
que depois se aprenda verdadeiramente. Os livros são apenas o trampolim 
na fase inicial e uma fonte para esclarecimento de dúvidas em situações 
futuras. O resto do salto deve ser finalizado pelo executante! 
 Ao longo deste documento, fiz menções a várias marcas registadas, 
que passarei a discriminar: 
 

Netscape é uma marca registada da Netscape Communications Corporation 
Microsoft Explorer é uma marca registada da Microsoft Corporation 

HomeSite é uma marca registada da Allaire 
Adobe Photoshop é uma marca registada da Adobe Systems Incorporated 
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para ouvir as minhas críticas, paranóias, picuinhices e afins. O seu poder 
empreendedor e as suas ideias sempre catalizaram o meu trabalho. 
 À  Doutora Lígia Ribeiro, deixo também os meus agradecimentos por 
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Vítor Carvalho, 23 de Dezembro de 1996. 
 

 Dois anos passaram e o documento —  inevitavelmente —  desactualizou-se em 
alguns pormenores. Esta segunda edição veio corrigir as erosões do tempo.  

O caminho percorrido foi substancial e o SiFEUP cresceu, contribuindo de 
uma forma significativa para a melhor divulgação de toda a informação relativa à 
nossa FEUP. 

A evolução do sistema e a constante preocupação em mantê-lo actualizado, 
condenará este documento a uma actualidade efémera. Ainda bem que assim é. 

 
Vítor Carvalho, 15 de Outubro de 1998 

 
 


